Microsoft Office
2003 : Excel

Microsoft Excel is the most widespread T
program for creating spreadsheets on the mar- (3 &) Wedons Ldate
| ket today. Spreadsheets allow you to organize R

information in rows and tables (which create (%] meum ’ |/EY Accessories
cells), with the added bonus of automatic [ % Dmm:s_&‘:% ma |
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mathematics. Spreadsheets have been used for |
i) Network Assodlates b [3] microsoft Office Access 2003

many, many years in business to keep track [ settigs
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of expenses and other calculations., Excel will [§d ;2 search +iE) Startup + i8] Mirosaft Office Excel 2008
keep track of numbers you place in cells, and ) Utities + /3] Microsoft office Infopath 2009
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if you define cells to refer to each other, any [
changes made in one cell will be reflected in EE - & Intnet Exlorer
these referring cells. It sounds a bit compli- |

;'g o o ‘15-3‘! Netscape 7.0
cated, but Excel makes it all a breeze. 34 £8] st oom.. I ST

Opening Excel: Start >> Programs >> pfQilieed 1
Microsoft Office >> Microsoft Office Excel 2003

Microsoft Excel will automatically open with a blank spreadsheet spanning many columns and rows. You
will notice a number of toolbars with many more options included.

Cell : A cell is a specific location within a spreadsheet and is defined by the intersection of a row and
column. Since most spreadsheets use numbers to define rows and letters to define columns, cells are often
referenced by a letter and number combination. Cells may contain several data types, including numbers, dates;
times, currencies, percentages, text, and other types of data. Most spreadsheet programs allow you to format

cells for different data types. which help ensure uniform entries across multiple ceils.
Standard Toolbar :

RalgRIs @m- - 8=-Be &

b

o

"84 O 7 6O W UWRERBYB

11. Insert Hyperlink : Inserts a hyperlink to an
' Internet location.

12. AutoSum : A drop-down menu of available
mathematical operations to perform, ~

13. Sort Ascending : Sorts the current selection
in ascending order. '
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1. New : Create a new, blank spreadsheet

2. Open : Open a previously saved spreadsheet
3. Save : Save your current spreadsheet

4. Permission :

5. Print : Prints the current document.

6. Print Preview : Preview the potential print of

the current document.
7. Research : Microsoft has enabled Information

which will walk you through the creation of a chart
/ diagram using the currently selected information.

Rights Management (IRM) within the new version of

|! Excel, which can help protect sensitive documents

from being copied or forwarded. Click this for more
information and options.

8. Copy : Copies the current selection to the

cliphoard, which can then be pasted elsewhere in the

document.
' @, Paste: Takes the current clipboard contents
and {nserts them. .

15. Microsoft Excel Help : Brings up the Excel
Help window, which will allow you to type in a key-word
for more information, or click anything on screen to di-
rectly bring up further information on that subject.

16. More Options : There are a variety of extra
tions you can call or add to the toolbar, such as
k, Sort Descending, Cut, Redo, etc. By
you can access these options; at
drag this toolbar outwards
e for these options

op
Spell Chec
clicking the triangle.
the same tlme, you can
more to make more available spac

' .'10. Undo : Unddes the last action in the docu-
/' Ment, reverting “back” a step in time.
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directly on the toolbar.
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14. Chart Wizard : Opens the “Chart Wizard,” i !
!
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Microsoft Office 2003 : Excel

imbiﬁzj Formatting Toolbar

£ Arial e 10 __‘7LBi.I; ﬂ =
- i 2 8 6

1. Font :-Change the font of the selected cell(s)
Size : Change the font size of the selection
Bold : Put the selection in bold face

Itatics : ltalicize the selection

Underline : Underline the selection

6. Align Left : Align the current selection to the |

left

7.
center

8. Align Right : Align the current selection to
the right

8. Merge & Center : Combine two selected cells
into one new cell that spans the width of both and
center the contents of this new cell

10. Currency Style : Change the style in which
currency is displayed

11. Percent Style : Change the style in which
percents are displayed

12. Decrease Indent : Decrease the indent of a
cell by approximately one character

13. Border : Add or alter the style of borders to
format a cell with

14. Fill Color : Select a color to fill the back-
ground of a cell with

15. Font Color : Select a color to apply to a se-
lection of text

To refer to a particular cell, you call it by its col-
umn letter, and then by its row letter. For example,
the cell in the uppermost left corner would be “A1."
The current cell{s) will always be listed in the “Name
Box,” which appears on the left below the toolbars,

Center : Align the current selection to the

Navigating the Spreadsheet : Yoy can use the
“Up,” “Down,” “Left,” “Right,” to move (one cell at a
time) throughout the spreadsheet, You can also sim-
Ply click the cursor into a cell). The “tab” button will
move one cell to the right. The “Enter” button will con-
firm the entered information and move one cell down

If you enter text or numbers that i
than the column allows, simply place yoilii-aélu:'urther
the line dividing two columns n sor on

ext to their
letters, and drag to the right or left untj] t;zsg:;:{tivs
Width is achieved. You can algo double-click this rgzl_

viding line to have Excel ay, ‘
viding cel automatically choose the hest
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A Simple Spreadsheet : _
A | B | C 1 D |

1 Grade 1_ Grade 2 Grade 3
2 Student 1 e’ _19!3' 80

{ 3 |Student 2 78, 900 B
4 |Student 3 8o, 100 100
5 |Student 4 86 88 90

{ 6 |Student5 0 0 0

This is what a basic spreadsheet may look like,

keeping track of the grades

for five students. As you'll

notice, numbers automatically align to the right, while
text automatically aligns to the left. Room has been

allowed at the top and the

left for colurmn and row

headings, which have been placed in bold.

Formula bar : The for-
mula bar in Excel is Io-
cated above the work area
of the spreadsheet. The
formula bar displays the
data or formula stored in
the active cell. The for-
mula bar can be used to
enter or edit g formula, a
function, or data in a cell.
Example The active cell
displayed the answer to
he furmula."l‘he actual
formula for the active cell

YL

—-——— g

B c |

bBavtiab s e
“

ATy F"-‘ L

h =C1°C2

Costefcar 20000
Tax rate Q07
Total Taxesf, 14001
b I o dErra, s
AN T ety

was displayed in the formula bar.

Simple Formulas :

E2 Y B =(E2rCan9s
A& [ B T ¢ [ 5 TET
e Grade 1. Grade 2 Grade 3
2 [Student 1 98, 100 80}
| 3_|Student 2 78 en g5
| 4 [Student 3 90’ 100 100
{5 iStudent 4 85 @3 90
| 6 [Student 5 o 0 Q

“92.67" was

“E2." The “formula bar” hag
it : =[Bz+Cz+D2}/3

nol entered as the contents for cell

the following entered into




i vicrosoft Office’2003 : Excel
" By following the normal order of o ‘
| - gontents of the three cells in parenthésise {g;t}qus ’ f«ﬁ
| £ are all added to each other, and then divided by
{ 3 This gives an average of the three grades, which is
| ten shown in the cell “E2" (where the formula was
g;tered)- ‘ S e )
| If you wanted to do the same fo [ Daka | Wind:
jrough 5, you would enter in shnﬂarrfosg:l?ﬁ:;sfozr EQQ’?’%:{‘ Window ﬂalp
each cell from “E3” to “E6” replacing the column and 1%.!, 20t :
row numbers where appropriate. ﬂ 3 — - : i
An easy method to replicate formulas is to select
the cell which contains the original formula (“E2” in A new window will appear asking how you would
this case), click the bottomn right corner of the selec- like to sort the information. Let's sort it by the av-
tion box, and drag down several rows (to “E6" in this erage grade, which is in Column E; be sure to set by
examnple). The formula will be copied down in each cell “Descending” order. If there were other criteria you
and will change itself to reflect each new row. ' | wished to sort by as secondary measures, you could |
- do so: let's select “Then by" as “Grade 3" just for the :

, [ce1ea/
‘ Now let's select the “Sort™ option from the “Data”
mienu, -

¥
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TOR2 b = '
T A =(B2+C2+D2)/3 practice of doing so (*Descending” order, as well). ]

, A | B | € 1 D t
11 _ . Grade1 Grade2 Grade3
&Stllt.le“t 1 ‘ P 98 X _100» o ED 92.67 "-“'-“"-"ﬁ;‘i‘;("._:'\ TR M T ey L L e i A S e :
‘3 \Student2 © 78 9o 85| 84.33 Sort ‘ B
"4 |Swdent3 | 90 10, 100|9BE7} | '
5 lswdentd 86 %5 ool sl " | | Sortby - e ")
% i JE N eyl S - .. ¥R — . . ‘
;?_vv"'-?!'.“.l%l.‘l 5...0_ 0 0L [(Column B} vl QO ascending |1|l
Pt fro e e e e e 2! (o) Descending ;;J;i!-

Insert Rows & Columns : You may find that you Thenby —-- - - e I !
need to insert a new, blank row where there isn't a : L H
| blank row any more. To insert a new blank row, place |Grade 3 | ] Onsgendtn? _____ *
your cursor directly below where you would like a new B (®Pescending! i
row. Select Insert >> Rows. To insert a new column, Thenby --- . e
place the cursor in a cell directly to the right of where
you would like the column. Select Insert >> Columns. | ]:] {3 Ascending . |
ﬁﬁ:‘*ﬁﬁ.’a},r\g:ﬁﬁ?ﬂ,l.yv‘:ﬁi%yi@r’k_'}r:":.ﬂ':.—w,.\'9'7—‘!7&‘_‘(}-‘.‘:“:&1 . ’ T O DESCEHdinQ ' i“f _
“Book1 ' ' - My datarangehas - - o- oo “ ’
“Insert. | Format Tools Dat G Headerrow O No header row |
OWs J \ -
Row ; ertlgns.,. ] l QK ] ﬁCantei ] AN
- .

: 5 Columns

Sorti-ng :*One of Excel's powerful features is its
abtlity to sort, while still retaining the relationships

among information.
dent grade example from above. What if we wanted

to sort the grades in descending order? First, let's se-
lect the information we want to sort.

For example, let’s take our stu-

" Excel will sort your information with the specifi-
cations you entered. The results should look some-
thing like this :

S =(B2+C24D)

=% =(B2+C2+D2)3

E2 -
B ot o e 5 : -» B"l'(‘,l c 1 " CD"':’V_:-‘ l E.\
> [Smdents .90 100 100’9667}
~lowdenti = 9 100 - B0:G2678

Swdentd , .86 & 90 %
5 |Student2 | 78 90 85 8433
G |Student 5 D, 0. o__0of
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. Cell Formatting : You may notice that, by defautlt,
Excel will leave as many decimal points as possible
within the cell's width restraints; as you increase the
cell's width, the number of decimal points increases.

T A .1 B | -C. .l D} E &
1 Grade 1 | Grade 2 | Grade 7
- 2 |Student3 | e 100 100| 96.6868667
.3 {Student1 | S8 100 80| 92.6666667
4 [Swdemd4 © 88! BB 90 B3
5 |Student2 . i 90 85; B4.3333333
- 6-1Student 5 ! 0! 1] 0 0

Select “Cells” from the “Format® menu. A new
window will appear with a wide variety of ways in
which to customize your spreadsheets.

|
|

Decimal places: ‘[z @f

(] use 1000 Separater {,)
Negative numbers;

{1234.10)
(£234.10) >

Number is used for general display of numbers, Curency and Accounting | |
| offer specialized formatting for monetary value,. [

Lox J Lcantﬂ

For example, if we wanted to set the percentages
fixed to only two decimal points, you can make this
selection under the “Number” category within the
“Number” tab. You can also set the formatting for
things such as the date, time, currency, ete,

The “Font" tab will also allow you to change the
default font used on the spreadsheet. The other tabg
provide even more ways to customize your spreadsheet
and its appearance; experiment with the settings to
see what works best for you. |

Chart Wizard : Excel allows

. ou to
r to ~ intermediate charts bas y create basic

ed off of information and
. Let's create a column

chart from the student grade data from before, First

highlight the data,

e

LT

- P
*. D ¥ I e

1

v

@ Chart,..

A new window will appear asking which type of

Columns

Worksheet

1

chart you would like to create. For this example, let's
do a basic pie chart. Select “Column” from the “Chart
Type” on the left side, and pick the first sub-type on
the right (a normal, 2D column chart).

~ Click “N
select your
spreadsheet
Since you've

ext.” In this window, you'll be asked to
“data range”; this is the area of your
that you wish to generate a chart from.
already selected the area before, it should

already be entered into the appropriate area. “Series
in" allows you to choose by which value you want to

arrange the

chart. Let's arrange it by rows; this will

break it down by “Grade” (such as Test 1, Test 2, ete.}
and comparing the student scores next to each other.

A ety
Py AL TR T R A M e w iy 1 o ST ST B T L L i
ﬂﬁn-w:iard “Step1-of 4'-Chart Type - = ‘Lo 7

Type

Standard Types |cmgp3_v]ypas, ',

{ [l X9 (seatter)

ity Area

ge J,t ;

. Chart sub-type;

 {Presadrodtopewsone )¢

=) . me
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"Chart Wizard ™ Step 7614 - Chart Satrce Bara

120
100 4 T
so Hf B - | B
a4 Bw t i
¥ A 5 !
g0 +1 i M ik
so Hf I 4 i
20 LE: Fi s 1:
e W & -k
o i . 7,1" b ®
Grade 1 Grade 2 . érades )

Data range:! [=Sheetl 1$A$11$E$6

Series in: ®j

1
i }

O Columns

r Cancel J [

<Back [ Next>

] {__Einish

).

Click “Next.” In step three you can give the chart a name (“Chart Title"), label the X and/or Y axis, ete.

{ e PR VR YR Sy a2 T L
5 AT P L

fChiart Wizard - Step'3 of 4"’-."8551'{6[:‘&{6;':’%3 '

TR, @ >3

r\

Titles 1____;1;_(35 " Gridllnesw“,Legend “ Data Labels H Data Table |

Chart title:
Eomparing students Scores |
120

Comparing Students Scores

Category (X) axis: T

| 100

20

value {Y) axis:

’1 1] s

waennd category KA1 3s 40

T BT o

20

Second wale (¥} axls

Grade1 Grade 2  Grade 3

]

Click “Next.” The final step will ask
sheet or in a new one; generally, you will pl

| Cancel l [ <»Eat;k"J|. "pexk > ] 1 Einlsh ]

whether you want the ¢
ace it within the same spreadsheet.

hart as an object in your current spread-

Kiran's Computef Literacy and Knowledge
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-\ rip i i
e e e b -

r<—:|__Earl'.1

Al O as new sheet:

LEH (@ As cbiectin:

r Cancel

Click “Finish,” and your chart will appear in your spreadsheet!

" b3 V" B r. TEATY bl e Ik
T T T Exool Doy T mp e R i A

:f:@»ﬁe Edt Vew Inseit Format Tools (Chat Window Help
ﬁ .

A B |. ¢ |.Db |- E F | .6
an Grade 1 - Grade 2 | Grade 3 ' i i
2 |Stadent 3 8Os 100! 100: __ 96.66665667 _#__“__j____#___ '
3 |Student1 | 88 100;  80] 9266666667 :
4 1Student 4 86 Bai 90! B8 o
5{Student2 | 78 80, 85 B4.33333333 o
-6 |Student § 0 1} 0; _ o i :
A i 1 l L . ~ ' o
8. ol ) 4]
19lj R Comparing Students Scores i
#H
12 120 ;
13
“1-&— R o o _ _ - ) ] -
15 d - 17 __ |=Student 3
ST ok E ] 14 —‘ B Student 1| |
:; 1B ; — |DStudent 4] |
18l T 14 |9 Student 2
Fol I L OStudent &
21 T g ; — '
224’ k]
;24 - Grade2 Grade 3
28 o
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1 1,All formula in Excel start with | :
: e (3) 400 i
(1].?'5 2) + @ 17 16. The intersection of a row and s
' p)/-_- @ - 5 column is called : 1
) None of these o L;None of these. (1) data @) a field T’
2. You can use a function to com- - - ;ltge t:z ]I_;‘l 1 shortcut key to (3} acell 5
| birll]egcx:;: from two cells into one creates art on chart sheet (4) an equation B
cell. But you can use an opera- (1A (5) None of these !
‘ . def;
tor to do the same thing, Which A 9 ault chart 17. There are three types of data |
operator is that? S h ':"menswnal column found in a spreadsheet j} '
c ) -
(W & (ampersand) 3) A;-rdim' , (1) data, words, numbers L
(2) = (equal sign) A 8.1 enspnal be.u‘ chart (2) equations, data, numbers %
(3) (space) 5 N mensional line chart (3) words, numbers, labels ;
(4} All of the above. 11 Yca‘ one of these {4} numbers formulas, labels ,
(5) None of these - [1]'-111'3an print (5) None of these o
8. Two common wildcard charac- | na;?nge of cells by range | 18. To select a column the easiest '
ters that Excel recognizes are (2} An et' method is to........ )
@*and? (2 <and > . entire worksheet (1) Double click any cell in the i !
@ Arand/ (4)+and - ) & single worksheet column P
(5) None of these A4) All of the above ] (2) Drag from the top cell in the i
4. The divide symbol i (5) None of these column to the last cell in the ;‘;
, yrmool 1s . | 12. You can create only a horizon- column ]
oL (2) D tal page break by first selecting [3}click the column heading '4
) (4)) (WA row below the row where {4) click the column label ”:'.'
(5) None of these you want the page break to (5) None of these g
B. The multiplication arithmetic occure 19, If you press ...... the cell accepts )
operator is represented by which (2) Acellin row 1 ‘ your typing as its contents. JI
of the following symbols? (3) A cell in column A “Y Enter (2) Ctrl+Enter (
(1)~ A2] * ‘ (4)aandc  (5) None of these (3) Tab {4) Insert i
3/ (4) X 13. You can create hyperlinks from {5) None of these i
{5) None of these the Excel workbook to 20. which of the following special i
8. To add two cells (Al and A2} (1) A webpage on company function keys allow the content !
together you use the following internet in cell L
formula (2) A web page on the internet (1) esc (2) shift ;
(H=Al + A2 (2 =Add{A1+A(2) (3) Other Office 97 application #3J return {4} Tab
{3) =together(A1:A(2) documents | {5) None of these . L
{4) A1 plus A2 (5) None of these (4)-All (5) None of these | 21. Which is not an advantage of f‘j
7.To make a number in cell C1 | 14. The cell reference from a range using computerized spread-
10% smaller than the number of cells that starts in cell Bl sheets? |
in C3 you enter and goes over ifo‘ column G and (1) flexibility of moving entries N
(1)=C3°1.10 (2)+C3*110 down to7ow 10 s...... (2) speed of calculation 3
(3) =C3%10 _{4y=C3*.90 (1) B1-G10 (2} BL.G10 (3) ability of generate tables !
(5) None of these ‘ (3) BI;G10 14 B1:GIO | {4}cost of initial setup f
8. On an excel sheet the active cell (5) None of these (5) None of these 3
in indicated by ... 15, The advantage of using a | 22, To select several cells or ranges b
] A dark wide boarder spreadsheet 1s : that are not touching each [
2) A dotted border (1) calculations can be done other, you would ... while select- b
(8) A blinking border automatically. e ‘
@ N ; ’i . (2) changing data automatically _rhold down the Ctrl key Lo
(I N‘”?e °f ah ove updates calculations (2) hold down the Shift key 3
= B iy one of these (3) more flexibility (3) hold down the Alt key
» The worksheet contains w%n of the above (4) hold down Ctrl + Shift key
i HYB5536 (2) 256 (5) None of these (5) None of these
- i s Kiran's Computer Literacy and Knowledge
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o '28. Each cell 1 a Microsoft Office |

Excel document is referred to
by its cell address, which is the
{1) cell's column label
{2) cell's column label and
worksheet tab name
(3} cell's row label
l}}cell‘s row and column la-
bels
(5) None of these
SBI Bank Clerk Exam, 19.08.2007

24. A certain spreadsheet shows in |,

Page Break Preview that cells in
Rows 1-25 have white back-
"ground. The cells in row 26 that
contain data have a dark grey
background, when you click the

Print button......

{1) nothing will print because
some cells with data have
been omitted

(2) only the cells with gray back-
ground will print

{3) the whole sheet will print

JA’) only the cells with white
background will print

(5) None of these

2B. A constant is another name for
this type of data:

{¥number (2) equation

(3) formula (4} description

(5) None of these

26. The view that puts a blue line |

around each page that would be

printed is the......

(1) Print Preview

(2) Normal View

[3yPage Break Preview

(4) Split View (5) None of these

27. Auto Calculate will quickly add

selected cells if you.......

(1) right click on the status bar
and select Sum

lzfé'hck the AutoCalculate but-
ton on the toolbar

{3)use the key combination
Ctrl+$ :

(4) Double click the selection

{5] None of these

28, The cell labeled 23. 54 the cell
labeled F5 refers to

(1) row F column 5
column F row 5
_(3] function available in cells

(4] function key F4
-~ (5) None of these’ |
29, when you are typing an equa-

tion into a cell the first thing |.

that must be entered is
(1) the first cell referenced
(2) parenthesis
(3) quotation marks
(4)an equal sign
(5) None of these
30. Using the AutoSum button will
replace in the selected cell......

(1) the sum of values in the |

cell's column

(2) nothing until you select a
range of cells

(3} the sum of the cell's row
unless you change the range

{4Ya formula which will add
values in the range Excel
guesses you want to add

(5) None of these

31. Bookl is an example of how ...

are numbered and named dur-

ing each work session

(1) Active cell (2) Formula bar

(3) Menu bar _(4}Name bo.zc

(5) None of these

32. Which of the following displays

the contents of the active cell?
(1) Active cell-{2] Formula bar
(3) Menu bar (4} Name box

(5) None of these

33. Graphics objects on a chart are
used to

(1) Add emphasis to chart data
(2} Add interest to a chart
(3) Help explain the chart data
14 (1), (2) and (3) -
" (5) None of these
34, What does SUMIF function do?

* HATAdds up cell values based on
a condition
{(2) Adds all the nuinbers in a
range of cells

(3) Returns a subtotal in a list

or database
(4) All of above
(5) None of these
35. You can insert labels for

(1) All the data markers on a
chart

(2) A data series
(3) A selected data marker
4) All (B) None of these

36. Tab scrolling buttons
. (1) Allow you toview a different
- worksheet
(2) Allow you to view additiona]
worksheet row dovm
(3) Allow you to view additiona)]
worksheet colurnns fo the
right
Allow you to view additiona}
sheet tabs
(5) None of these
37. All macro keyboard shortcuts
include the ...... key -
AT Al (2) Ctrl
(3) F11 (4) Shift
(5} None of these
38. To open the Format Cells dia-
log box, press

(1) Alt + 1
Y Cirl + 1
(3) Ctrl + Shift + 1
(4) F1 (5) None of these
39, You can add a hyperlink to your
worksheet by pressing
(1) Alt + K (2) Ctrl + H
3 Cirl + K

(4) Ctrl + Shift + K
(5) None of these
40.To move to the previous
worksheet, press
(1) Alt + PgUp 2 Ctrl + PgUp
(3) Ctrl + PgDn
'(4) Shift + Tab
(5) None of these
41. Hyperlinks can be
{1) Text
(2) Drawing objects
(3) Pictures  {4}-All of above
{5} None of these
42, To activate the previous cell in
a pre-selected range, press
(1} The Alt key
(2) The Tab key
{8) The Enter key
(4FNone of the above
(5) None of these
43. Which button do you click to
add up a series of numbers?
MY The autosum button
{2} The Formula button
(3) The quicktotal button
[4) The total button

{5) None of thege

Kiran's Computer Literacy and Knowledge —




| 34 When the formula bar is active,
|- you can see ‘

. {3) The enter button

45. To copy formatting from one area

486. In a worksheet you can select

. Micmédft-‘ Ofﬁ*cé. ‘2003 : Excel

(1) The edit formula button
(2) The cancel button

-All of the above
(5) None of these

in a worksheet and apply it to

another area you would use :

(1) The Edit>Copy Format and
Edit>Paste Format com-
mands form the menu.

{2) The Copy and Apply Format-
ting dialog box, located un-
der the Format>Copy and
Apply menu,

(3) There is no way to copy and
apply formatting in Excel -
You have to do it manually

{4¥The Format Painter button
on the standard toolbar

(5) None of these

(1) The entire worksheet
(2) Rows
{3) Columns
{4 All of the above
{(5) None of these
47. When you link data maintained
in an excel workbook to a word
document
(1) The word document can not
be edit
{2 The word document contains
a reference to the original
. source application
(3) The word document must
contain a hyperlink
(4) The word document contains
a copy of the actual data
(5) None of these
48..Which area in an excel window
_allows entering vaiues and for-

mulas, |
(1) Title bar (2] Menu-bar
[3yFormula bar

{4) Standard toclbar

{5) None of these
Allahabad Bank Clerk
Exam,.31.08.2008
48, To hold row and column titles
. in place so that they do not
" seroll when you scroll a

the window menu

[2)Freeze panes command on
the window menu
(3) Hold titles command on the
edit menu
{4) Split command on the win-
dow menu
{5) None of these

50. To edit in an embedded excel
worksheet object in a word
document
¥y Use the excel menu bar and
toolbars inside the word ap-
plication
(2) Edit the hyperlink
(3) Edit the data in a excel
source application
(4) Use the word menu bar and
toolbars
(8) None of these
51. To create a formula, you can
use:
{1) Values but not cell refer-
€nces
{2) Cell references but not val-
ues
(3) Values or cell references al-
though not both at the same
time
14T Value and cell references
(5} None of these
52. Status indicators are located
on the
(1) Vertical scroll bar
(2) Horizontal scroll bar
{3yFormula bar
(4) Standard toolbar
(5) None of these

oldest spreadsheet package?
A4yvisiCale  (2) Lotus 1-2-3
(3) Excel {4) StarCalc
{5) None of these
54. Rounding errors can occur
A en you use multiplica-
tion, division, or exponen-
tiation in a formula
{2) When you use addition and
gubtraction in a formula
(3) Because excel uses hidden
_decimal places in computa-

(1) Unfreeze panes command on |

§3. Which of the following is the

(4) When you show the results
of formulas with different
decimal places that the cal-
culated results

(5) None of these

' 56. You can copy data or formulas

(1) With the copy, paste and cut
commands on the edit menu
(2} With commands on ta short-
cut menu -
{3) With buttons on the stan-
dard toolbars
A4TAll of the above
(5) None of these
56. You can not link excel
worksheet data to a word docu-
ment
(1) With the right drag method
(2) With a hyperlink
(3) With the copy and paste spe-
clal commands
,[With the copy and paste but-
tons on the standard tool-
bar.
{5) None of these

| 57. Which of the following is a popu-

lar DOS based spreadsheet

package? .
(1) Word (2) Smart cell
(3) Excel A4} Lotus 1-2-3

(5) None of these
58. An excel workbook is a collec-
tion of
(1) Workbooks
2 Worksheets
(3) Charts
(4) Worksheets and charts
(5} None of these
59. Excel files have a default exten-

sion of
£ Xis (2) Xiw
(3) Wkl (4) 123

(5) None of these

80, You can use the format painter

muliiple times before you turn
it off by

(1) You can use the format

painter button on ly one

time when you click it
42y Double clicking the format
painter button

(3) Pressing the Ctrl key and

clicking the format painter

. button

tion

- worksheet click the

Kiran's Computer Literacy and Know

ledge =

[ ciz-i69]

e

AT i o

TR T ey

pap e




Microsoft Office 2003 ; Exce

{4]-1_3'ressix41g'thé Alt key and

1 By button
(5) None of these
61. What function displays row
4 data in a column or column
" ' data in a row?
(1) Hyperlink (2) Index
A _{3) Transpose (4) Rows
F (5) None of these
82. When you insert an Excel file
into a Word document, the data
are
(1) Hyperlinked
A2 Placed in a word table
{3) Linked (4) Embedded
(5) None of these
©63. Except for the ....... function, a
formula with a logical function
shows the word “TRUE" or
“FALSE" as a result
Jilgia (2) AND
{3) OR (4) NOT
(5) None of these
64. Macros are “run” or executed

from the ...... meni,
(1) Insert (2) Frmat
_k3Y Tools {4) Data

{5) None of these
65. You can open the consoclidate
dialog box by choosing Consoli-

date from the ...... menu,
(1) Insert (2) Format
(3) Tools A4 Data

(8) None of these

66. Each excel file is called a work-
book because
(1} It can contain text and data
[2) It can be modified
I37Tt can contain many sheets

chart sheets

{(4) You have to work hard to
create it

(5} None of these -

cel produce?
(1) Line graphs and pie charts
~ only
{2) Only line graphs
48 Bar charts, ine graphs and
pie charts
{4) Bar charts and lne graphs
- only
A {5) None of these

clicking the format painter

including worksheets and

67. Which types of charts can ex-

68. How are data organized in a
spreadsheet?

(1) Lines and spaces

(2) Layers and planes

(3rRows and columns

(4) Height and width

(5) None of these

SBI Clerk Exam, 06.01.2008

69. What does the VLOOKUP {unc-
tion do?

(1) Looks up text that contain
W

{2) Checks whether text is the
same in one cell as in the
next

AB3)Finds related records

(4) All of above

{5) None of these

70. Gridlines

(1} May be turned off for display
but turned on for printing

(2) May be turned on or off for
printing

(3) The be tumed off for display
and printing

44 a, band ¢
(5} None of these

71.You can print only an embed-
ded chart by

(1) Moving the chart to a chart
sheet before you print.

{2) Formatting the chart before
you print

(3) Selecting the chart before
you print

Mra andc
(5} None of these
72, Which of the following is a cor-
rect order of precedence in a for-
mula calculation?

(1) Multiplication and division,
eéxponential positive and
negative value

(2) Multiplication and division,
Positive and negative values,
addition and subtraction

(3) Addition and subtraction,
Ppositive and negative values,
exponentiation

_{4'None of above
| (5) None of these
73. A function inside another func-

tion is called a ...... function.

Kiran's Computer Literacy and Knowledge

Nested.  (2) Round
(3) Sum (4) Text
(5) None of these

74. How should you print a selecteq

area of a worksheet, if you)

want to print a different area
next time?

(1) On the file menu, peint tg
print area, and then click set
print are(1)

270n the file menu, click
print, and then click selec.
tion under print what

{3} On the view menu, click cus-
tom views, then click add

{(4) All of above

(5) None of these

Your German supplier still in-

voices for parts in deutsche

marks. How can you have Ex-
cel convert those sums to Eu-

Tos?

(1) On the Insert menu, click
Symbol and from the cur-
rency symbols subset, select
the Euro sign.
2/On the tools menu, click

Add-Ins, and select the Euro
Currency Tools check box

(3) Apply a selected background
color

(4) All of above

(5) None of these

76. Which function calculates your
monthly mortage payment?
ATPMT (payments)

(2) NPER (number of periods)
(3) PV (presént value)

(4) All of above

(5) None of these

| 77.1f you are working in English

(US), Chinese or Japanese, Ex-

cel 2002 can speak data as you

eénter it, to help you verify ac-
curacy. How do you activate

" this feature?

VT Point to speech on the tools
menu, and then click show
text to speech toolbar.

{2) Click validation on the data
menu

{3) Point to speech on the tools

menu, and then click speech
recognition

75.
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yictosoft Office 2003 : Excel ;
o (4} All of above 84. To del N 7 ‘ ;
. - . » 1o delete an incorrect charac- | [T og r———
48, You can open the Sort dialog erase to the right of the inser- | 33.(4). ] 84.(1)] 35.14)] 36.(4)
. box by choosing Sort from the tion point. 37.(1) | 38.(2)] 38.(3)| 40.(2) ;
voeeres THETILL (1) press the left mouse ke 41, (4) | 42.(4)] 48.(1}| 44.(9) '-
(1) View (2) double - click the ri)éht 45.(4) | 46.14)| 47.2) 4803 :
(2) Format mouse key 49.(2) | 50.(1)] 51.(4)] ©2.(3) i
(3) Tools  (4).Data (3) press the BACKSPACE key | ::' g; ﬁ gi ?,3 (‘:] 5. 1
(5) None of these A4Ypress DELETE key 6L 62 @ (1)) 60.12 L
79. when working in the page break (5) None of these 6; :4; =y :3; g: :;i g; :gl
preview, you can - Allahabad Bank Clerk | | 69. (3j 70: @) 71: @ 72' [4: E
(1) view exactly where each page Exam, 31.08.2008 | |—= : ——— y
P 73.() | 74. 2] 76.(2)] 78.(1) ¥
break occurs 88, The most common subtotal —— : ; 1
1 Subt 77.() | 78.@| 70.4)| 80.& :
[2] add Or remove pagc breaks used Subtotals command is 8L {1} 82 {2} 83 15] 84 ( 4} ’.:
(3) change th the function, which | }—- - : — f
ge the print area : ‘ ‘ ;
( 4Y§1 of above causes Excel to display a sum 86.(2) | 86.(1] 87.12)| 88.(14 E
5) N £ th . each time the control field it
one of these change. gEXPMNAT‘IONS E i
80. A data map is helpful (1) ADD A2y SUM ‘
{1) When you have too much (3) TOTAL (4) LIST 2. (1) Use the ampersand (&) to
data to chart (5) None of these Join, or concatenate, one or |
[}}'To show a geogra hi distrd more text strings to produce a i
graphic distri- | Alighabad Bank Clerk sirigle piece of text. Operators ;
bution Of data .&amr a1 08.2008 speetfy the type Of calculaﬂon
{3) To compare data points 86. By default, Excel positions that you want to perform on j
(4)To show changes in data textinacell __. the elements of a formula.
over time ‘Teft ~ aligned Example if u enter in formula i
(5) None of these (2) right - aligned bar =(*North"&"wind") it show g
result “Northwind” N
81. In MS-Access, a table can have (3) centered (4} justified 3. (1) the wildeard ch , -
_primary key /keys. (5) None of these + (1) the wildeard characters can .
. be used as comparison crite-
(¥yOne (2) Two Allghabad Bank Clerk ria for filters, and when
‘ , Exam, 31.08.2008 » and W i
(3) Three (4) Four , ‘ searching and replacing con- i
(5) None of these 87. To centri a paragraph using tent.* ? and ~ are the wild card 3
Allahabad Banlk Clerk shortcut keys, press : characters. l
Exam, 31.08.2008 (1) CTRL + C 2)CTRL + E 8. (1} active cell: The selected cell il
2. cells involves creating (3)CTRL+L (4) CTRL + R in which data is entered when 1}
m cell by combining two (5) None of these you begin typing. Only one cell .
or more selected cells Allahabad Bank Clerk is active at a time. The active g
e Exam, 31.08.2008 | cellis bounded by a heavy bor-
(1) Formatting | gs. Which of the following is the der |
{2y Merging latest version of Excel? 12. (1) Insert vertical or horizon- -
(3) Embedding (1) Excel 2000 (2) Excel 2002 tal pzllge brgafs Sfle&t aﬂ!‘g';*’ 4
(4) Splitting (3) Excel ME - {4 Excel XP or column below or to the t
(5) None of these ) None of these of where you want to insert a
7 horizontal or vertical page :
Allghabad Bank c"’"’; Allahabad Bank Clerk break, right-click, and then -
o a1 E‘g:g::af:ﬁﬂf Exam, 31.08.2008 | . click Insert Page Break.
A s rectar ,
. : , - : 24. (4) In page break preview , the
rows & columns used to enter | % ANSWERS = selectggg print anl:a shown in

white background with blue

B

data. Zz. | s 40}
{1) cell 1. (3] - T 7' @l 8o line around each page. and
(2) workspace 8. (2) 6. (1 . dark grey area is not a print
3) worksheet o.(m [ 10.)] T1.@] 121 area , this area contain blank !
[ epre e _i8.(4) | 14, @)} 15. @] 16.@ cell which not require to print. !
{5)130&;!5:1 and mﬂm‘k cteric | [ 228 22. (1] 23. @] 24. 4 "Jeft to the formula bar. 7
Htahabad 26. (1) | 26.0)| 27-(2] 28.12 Qoa g
E:.mm. 31.08.2008 i
N
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